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Experiment No.: 1 

Experiment Name : Study of Power Factor Improvement (PFI) Plant. 

 

Equipment required : 

Capacitor bank 

Induction load 

AC Voltmeter 
AC Ammeter 

AC Wattmeter 

 

Introduction : 

For fixed power and voltage, the load current is inversely proportional to the power factor. Lower the 

power factor, higher the load current and vice-versa. At lower power factor the KVA rating of the 

equipment has to be made more, making the equipment larger and expensive. Moreover, to transmit 

or distribute a fixed amount of power, the conductor size has to be greater at low power factor. 

Consequently, more I2R losses result. Therefore, low power factor is objectionable in the power 

system. 

The low power factor is mainly due to the fact that most of the industrial loads are inductive and 

therefore take lagging currents. In order to improve the power factor, some elements or devices taking 

leading current should be connected in parallel with the load. One of such element could be capacitor 

bank. In this experiment, study will be made on a PFI plant controlled by manually where capacitor 

bank switches are turned ON and OFF according to the power factor such that nearly standard power 

factor is achieved. 
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Figure 1.1 :  
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Procedure : 

1. Connect the load with the PFI plant and arrange the supply for the combination. 

2. Vary the load and observe the switching of the capacitors. Also notice the overall power 

factor. 

3. For each set of load, take reading of the load currents, voltage across the load, total watt for 

the load and calculate the power factor for each set of load. 

Table 1.1 : 

Observation 
V 

(Volt) 

I 

(mA) 

Power 

(Watt) 
Pf 

Capacitance 

(Practical) 

IC 

(mA) 

Capacitance 

(Theor) 

1        

2        

3        

4        

5        

6        

7        

8        

9        

10        

 

 

Report : 

1. Give an idea to design a dynamic PFI plant for a load with variable power factor. 

2. Describe in brief the types of reactive power compensation system. 

3. An industry operating at 220V (L-N) has a maximum load of 400KVA per phase and the 

minimum load is half of its rated load. It is assumed that the reactive power requirement of 

the industry is 40% of its KVA demand. If the targeted power factor is 95%, design a 5 step 

switching module for 5 different load conditions in between the maximum and minimum 

capacity. What will be the values of 5 capacitances for optimum pf control and what should 

be the worst scenario with this system? 
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Figure 1.2 :  
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Experiment No.: 2 

Experiment Name : Observation the phase shift in ∆-Y transformer in a 3-𝝋 transmission line. 

 
Equipment required : 

3-φ transformer 

3-φ variac 

AC voltmeter(0 – 500V,0 – 100V) 

Oscilloscope × 2 
 

 

Theory : 

Normally, to remove the zero sequence current in a Power System Network, one of the sides of the 

transformer is connected in ∆. Depending on the type of connection,∆-Y or Y-∆ or ∆-Z ; there is a 

definite phase shift between the primary and secondary voltages. These phase shifts will have to be 

determined or known to calculate the fault currents and for paralleling purpose. The connection of the 

phases of two windings of a transformer together with the phase shift between the primary and the 

secondary is known as the vector group. The numerical index (hour no.) shows the displacement of 

the vectors. Capital letters apply to H.V. winding and the small letter L.V. windings. If shows 

(numerical index) by what multiple of 30° the L.V. vector lags(anti-clockwise rotation of vectors) 

behind the H.V. vector. 

Y Y
 

Figure 2.1 :  

For example , Dy5 means H.V. in ∆, L.V. in Y and the voltage in H.V. side(∆) leads L.V. side (Y) by 

5 X 30= 150°. 

 

Determining the relative polarity of a Transformer : 

The polarity test of the Transformer should be required for performing this experiment otherwise you 

cannot get the actual result (30° phase shift between the Primary and Secondary side of the 

Transformer) from this experiment. There are two ways to verify the polarities as illustrated in the 

forgoing figure. In the 1st approach, which is suitable for laboratory work, a dc voltage is applied 

through a switch to one side and a dc ammeter is connected to the other side. On connecting the 

switch , if the ammeter deflection is in forward direction then the terminal connected to the positive 

terminal of the ammeter is considered positive. 
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A more realistic approach is to use KVL after applying a single phase supply (A.C or D.C) to one side 

of the winding as illustrated in the later figure. 
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Figure 2.2  
 

 

A)  PRIMARY DELTA AND SECONDARY WYE (Mode-1): 

Connect the Primary and Secondary as per following diagram. 

VRY = -VH3-H4 . 

Vab =Van – Vbn . 

Apply 50V to the primary. 

Find the phase shift between the Primary and Secondary. 

Confirm whether the vector Group is Dy1.  
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Figure 2.3 : Δ – Y Connection (Mode – 1) 
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Figure 2.4 : Vector Diagram (Mode – 1) 

 

B)  PRIMARY WYE AND SECONDARY DELTA (Mode-2): 

Connect the primary as per following diagram, keeping the Secondary fixed. Through variac apply a 

small 3-Ø voltage (say 50V). See the phase shift between RY and ab on a duel channel oscilloscope. 

Confirm whether the vector is Dy11. 

VRY = VH1-H2(phase-b) 
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 (  )   connection is required in generating side and Wye (Y) connection is required in ∆Why Delta

in a transmission line? transmission side 
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Figure 2.5 : Δ – Y Connection (Mode – 2) 
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Figure 2.6 : Vector Diagram (Mode – 2) 

 

Report: 

1.  

 

2. Explain the necessity of using the Wye-Delta transformer in power sytem? 

3. Draw the connection and vector diagram for the group Dy5. 
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Experiment No.: 3 

 

Experiment Name : Determination of Symmetrical Components of current under different fault 

conditions of a synchronous Generator. 
 

 

Equipment required : 

Synchronous Motor/Generator. 

3Ø induction Motor 

AC Ammeter (0-3A) 

AC Voltmeter (0-500V) 

Variac 

 

 

 

 

Introduction: 

According to Fortescue’s theory, three unbalanced vectors Va ,Vb and Vc can be replaced by a set of 

three balanced system of vectors. 

The Three symmetrical component vectors replacing Va , Vb and Vc are : 

1. Positive sequence component vectors of equal magnitude but displaced in phase from each other by 

120° and as the same phase sequence as the original vector. 

2. Negative sequence component which has three vectors of equal magnitude but displaced in phase 

from each other by 120° and has the phase sequence opposite to the original vectors. 

3. Zero sequence component which has three vectors of equal magnitude and are in phase with each 

other. 

 

Vc1 Va1

Vb1

Va2

Vb2

Vc2

Va0 Vb0 Vc0+ + =

Va1

Va2

Va0

Va

Vb1
Vb2

Vb0

Vb

Vc1

Vc2
Vc0

Vc
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(A) Single line to Ground fault on an unloaded Generator: 

Simulate a single line to ground fault on the phase “a” of the unloaded Generator. 

+
Eb

Ea

Ec

c

a

b

Ic

Ia

Ib

PM

A

50 Ω

0.5 A

3 – ф Induction Motor

  

Figure 3.1 : Single Line to ground fault of an unloaded Generator. 
 

The condition at the fault are: Ib = 0, Ic  = 0 

From the following matiix, determine Ia0, Ia1, Ia2. 
 

 

Ia0

Ia1

Ia2

 =
1

3
 
1 1 1
1 a a2

1 a2 a
  

Ia
0
0
  

Measure Ia with an ammeter. 

(B)  Line to Line fault 
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Figure 3.2 : Line to Line fault. 
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Here, Ib = -Ic & Ia = 0 

After putting these values we will get 

 

 
Ia0

Ia1

Ia2

 =
1

3
 
1 1 1
1 a a2

1 a2 a
  

0
−Ic

Ic

  

  

     ∴ Ia0 = 0 

                                

Ia1= 1/3[a2Ic –aIc] = 1/3Ic[a
2-a] 

                                

Ia2 = 1/3[aIc – a2Ic] = 1/3 Ic[a-a2] 

                             

  ∴ Ia1 = -Ia2 

Measure Ib or Ic by an ammeter. 

 

 

 

 

 

 

(C) Double line to Ground fault 
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Figure 3.3 : Double Line to Ground fault. 

 

 

 
 
Ia0

Ia1

Ia2

 =
1

3
 
1 1 1
1 a a2

1 a2 a
  

0
Ib

Ic

  

                              

  Ia0 = 1/3[Ib+Ic] = In/3 

                                

Ia1= 1/3[aIb + a2Ic]  

                                Ia2 = 1/3[a2Ib + aIc] 

Measure In by an ammeter. 

Report : 

1. For the different type of fault, discuss and compare the different sequence network currents. 

2. What are the advantages of analyzing a fault by sequence network? 
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Experiment No.: 4 

Experiment Name : Measurement of Positive Sequence Impedances for Rotating Machine. 

 

Equipment required : 

Synchronous Motor/Generator 

3-Ø Induction Motor 

A.C. Ammeter (0-1A) × 2 

A.C. Voltmeter (0-250V) 

Variac 

 

 

Introduction: 

According to Fortescue’s theory, three unbalanced vectors Va ,Vb and Vc can be replaced by a set of 

three balanced system of vectors. 

The Three symmetrical component vectors replacing Va , Vb and Vc are : 

1. Positive sequence component vectors of equal magnitude but displaced in phase from each other by 

120° and as the same phase sequence as the original vector. 

2. Negative sequence component which has three vectors of equal magnitude but displaced in phase 

from each other by 120° and has the phase sequence opposite to the original vectors. 

3. Zero sequence component which has three vectors of equal magnitude and are in phase with each 

other. 

 

Vc1 Va1

Vb1

Va2

Vb2

Vc2

Va0 Vb0 Vc0+ + =

Va1

Va2

Va0

Va

Vb1
Vb2

Vb0

Vb

Vc1

Vc2
Vc0

Vc
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At constant If, divide Voc by Isc to determine Z1.

. Calculate the positive sequence impedance from the graph.

 

 

 

Va = Va1+  Va2 + Va0 

Vb = Vb1 + Vb2 + Vb0 = a2Va1 + aVa2 + Va0 

Vc = Vc1 + Vc2 + Vc0 = aVa1 + a2Va2 + Va0 

 

Va

Vb

Vc

 =  
1 1 1
1 a2 a
1 a a2

  

Va0

Va1

Va2

          =>        

Va0

Va1

Va2

 =
1

3
 
1 1 1
1 a a2

1 a2 a
  

Va

Vb

Vc

  

 

Objective: 

The objective of this experiment is to observe the sequence impedances and sub-transient reactances 

of rotating machine. 

Measurement of Positive Sequence Impedance (Z1) : 

Connect the machine as per following diagram and run the machine at synchronous speed in proper 

direction with the help of prime mover. Keep the switch in the OFF position to perform the open 

circuit test. Take reading of voltmeter (V) for various If. Next reduce the excitation to minimum by 

putting total resistance in the field circuit and take readings of short circuit current ( Isc) for the similar 

If. Draw V vs If and Isc vs If  
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Fig : Experimental setup 
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V  (volt)oc

 

Table 1 

If(ma)  Isc(ma) 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

 

 

 

 

 

 

 

 

 

Report:

 

1. In first step how can we calculate

 

that the measured impedance is the positive sequence impedance 

of the machine?

 
2. What is the practical application

 

of sequence impedances of power system?

 

Z1 = 
𝐼𝑓 𝑎𝑡 𝑟𝑎𝑡𝑒𝑑 𝐼𝑎 𝑜𝑛 𝑠𝑦𝑛 . 𝑠𝑡 .𝑐𝑘𝑡 .

𝐼𝑓 𝑎𝑡 𝑛𝑜𝑟𝑚𝑎𝑙 𝑜 .𝑐 .𝑣𝑜𝑙𝑡𝑎𝑔𝑒

Also show that the same result can be obtained from the following equation.
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Experiment No.: 5 

Experiment Name : Measurement of Sequence Impedances and Sub – Transient Reactances for 

Rotating Machine. 

 

Equipment required : 

Synchronous Motor/Generator 

3-Ø Induction Motor 

A.C. Ammeter (0-1A) × 2 

A.C. Voltmeter (0-250V) 

Variac 

 

 

Introduction: 

According to Fortescue’s theory, three unbalanced vectors Va ,Vb and Vc can be replaced by a set of 

three balanced system of vectors. 

The Three symmetrical component vectors replacing Va , Vb and Vc are : 

1. Positive sequence component vectors of equal magnitude but displaced in phase from each other by 

120° and as the same phase sequence as the original vector. 

2. Negative sequence component which has three vectors of equal magnitude but displaced in phase 

from each other by 120° and has the phase sequence opposite to the original vectors. 

3. Zero sequence component which has three vectors of equal magnitude and are in phase with each 

other. 

 
Vc1 Va1

Vb1

Va2

Vb2

Vc2

Va0 Vb0 Vc0+ + =

Va1

Va2

Va0

Va

Vb1
Vb2

Vb0

Vb

Vc1

Vc2
Vc0

Vc

 

 

 

 

 

Va = Va1+  Va2 + Va0 

Vb = Vb1 + Vb2 + Vb0 = a2Va1 + aVa2 + Va0 

Vc = Vc1 + Vc2 + Vc0 = aVa1 + a2Va2 + Va0 

 

Va
Vb
Vc

 =  
1 1 1
1 a2 a
1 a a2

  

Va0
Va1
Va2

 

=>        

Va0
Va1
Va2

 =
1

3
 
1 1 1
1 a a2

1 a2 a
  

Va
Vb
Vc
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Objective: 

The objective of this experiment is to observe the sequence impedances and sub-transient reactances 

of rotating machine. 

A)   Method of test for Sequence Impedance : 

i) Measurement of Negative Sequence Impedance (Z2) : 

Connect the machine as per following diagram and drive it at rated speed and apply the reduce voltage 

to calculate approximately the rated current. Since negative sequence currents flow in this case there 

is possibility of hunting which results in oscillation of the ammeter. The negative sequence impedance 

is given by: 

Z2 = V/√3I 
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Since it is similar to L-L fault with alternator unloaded 

Ia = 0, Ib = I, Ic = -I, Vb = Vc 

Ia1=1/3(Ia+aIb+a2Ic), Ia2=1/3(Ia+a2Ib+aIc), Ia0 = 1/3 ( Ia + Ib + Ic) 

Substituting Ia, Ib&Ic 

Ia1 = 1/3 ( 0 + aIb + a2Ic) = 1/3 (a - a2) Ib  ; 

Ia2 = 1/3 ( 0 + a2Ib + aIc ) = 1/3 (a2 - a) Ib  ; 

Ia0= 0 ; 

∴ Ia1 = -Ia2 ; similarly, Va1 = Va2 



AUST/EEE

 

iii) Measurement of Zero Sequence Impedance (Z0) : 
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The machine is at stand still and a reduce voltage is applied.  The zero sequence impedance is given 

by: 

    

Z0 = V / 3I 

B) Method of test for Sub – Transient Reactances (Xd", Xq") : 

Connect the machine as mention below and apply V across any two terminals with the rotor at rest 

and short circuited through an ammeter. The rotor is rotated by hand and it will be observed that for a 

fixed applied voltage, current in the field varies with the position of the rotor. When the rotor is in the 

position of maximum indicated If (the direct axis position of the rotor), one half the voltage required 

to circulate rated current is equal to the direct axis sub-transient reactance Xd” and the position of 

minimum indicated  If   the quad. Axis  Xd" is obtained. 

VL-L  = Imax = Imin = 

Xd", = VL-L / Imin 

Xq" = VL-L/ Imax 

Also derive the expression  

1. In first step how can we 

2. What 
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Report: 
 

 

calculate  that the measured impedance is the negative sequence 

impedance of the machine? 

are the practical application of positive, negative and zero sequence impedances of power 

system? 

Z2 = V/√3I
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Experiment No.: 6 

Experiment Name : Study of voltage surge protector. 

Equipment required: 

IC 555 

Relay-4V 

X-former-6V 

Diode 1N4001 × 3 

Resistor - 10K,1K 

Capacitor- 1μF, 1000 μF × 2, 10pF 

Red LED × 1 

DVM 

 

 

Introduction: 

We may wish to apply power to one part of a system and wait for a short interval before starting some 

other part of a system. For example, we may need to re-set all counter to zero before starting a 

personal computer at the beginning of a business day. A circuit that solves this problem is shown in 

Fig-02 

In the circuit of Fig-01, power is applied to a system when the switch is closed. The IC555’s output 

goes high for a period of time T and then goes low. T is found from equation t=1.1RaC. This type of 

startup pulse is typically used to reset counters and initialized computer sequences after a power 

failure. It can also allow time for an operator to exit after an alarm system has been turned ON before 

the system is being alarmed. 

Vcc

15V

GND

1

OUT 3

4 

RESET

8

VCC

7 DISC  

6 THRS

CTRL

5

Vo

To delayed start

To system

IC 555

Ra

Va

C

Power
On

Off
0 t

0

Va

VUT = 2/3 Vcc

VLT = 1/3 Vcc

0

15

t

t

T=1.1RaC

Relay off

Vo

 

 
Fig 1: Output Vo does not high until a time interval after power is applied. 

 

Sometimes while any electrical or electronic equipment is ON, the electricity might be fail. For some 

reasons we may not be able to switch OFF the supply after the supply is cut or power may be restored 

before we can switch the supply OFF. A voltage surge at the time of power ON may damage sensitive 

appliances like TV, VCR, Refrigerator, PC etc. 
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The first part of the circuit is step-down the mains supply and rectify it to DC voltage which includes 

a step-down transformer, two rectifier diodes, and a smoothing capacitor. The second part is a 

monostable multivibrator using a 555 IC. The output of this IC is sufficient to drive the relay. 

It disconnects the power supply when power fails and connects it again automatically after a few 

sec/min. Red LED starts glowing when power comes back. The time period can be adjusted by 

changing the values of RT and CT from the equation T= 1.1RTCT, as time interval in seconds. 

 

1 GND

2 TRIG

3 OUT

4 RESET

VCC 8

DISC 7 

THRS 6

CTRL 5

LOAD

Red

LED

1 k
+ CT103 pF1 F

10 k

RT

6 V Relay

220V – 6 V

N/C

N/O

C/T

 

Fig 2: Voltage surge protector circuit. 

 

 

Reports: 

1. Describe the operation of the voltage surge protector circuit (fig-2). 

2. What are the features of this circuit? 

3. What will be happened if there is no voltage surge protection circuit in an electronic devices or 

refrigerator? 

4. Can you improve this circuit? If you can, draw the circuit and describe the operation. 

 

 

1000 μF

μ
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Experiment No.: 7 

Experiment Name : Study on voltage instability protection from the mains supply. 

Equipment required : 

12V Transformer - 1pc 

Diode(1N4001) – 2pc 

Capacitor(1000 μF , 25V) – 1pc 

Transistor(C828) – 2pc 

Zener Diode(5.6V) – 1pc 

Resistor(1K) – 3pc 

Relay(12V) – 1pc 

LED(red) – 1pc 

Load(100W bulb or LED in series with at least 100K resistor) – 1pc 

Variac – 1pc 

Bread Board – 1pc 

 
 

Introduction: 

Voltage instability in the mains supply lines is a common phenomenon. While electric gadgets like 

heaters, fans, bulbs remain unaffected by it, but more sensitive devices like air conditioners, TV’s, 

music systems etc tend to get easily damaged by such fluctuations. 

Here a mains voltage limiter (‘Low’ to ‘High’ volt) circuit is discussed which can be used to protect 

equipment from both ‘High’ as well as ‘Low’ voltage. It is ideally suited for sensitive electronic 

devices and can be easily incorporated into any existing manual voltage stabilizer or used as an 

independent unit. 

LOAD

Red

LED

1
0
0
0
 μ

F

220V – 6 V

Q2
VR2

10 kΩ

1 kΩ

D3

5.6 V

VR1

1 kΩ

1 kΩ

1 kΩ

D1

D2

Q1

12 V Relay

N/C

N/O

C/T

 

Note: VR1 is used to set the high limit and VR2 is used to set the low limit. 

Report: 

1. Explain the operation of the circuit. 

2. What are the features of this circuit? 

3. The purpose of using the the zener diode? Is the circuit operated properly if the value of the zener is 

chosen 15V or 1.5V? 
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8Experiment No.:  

Experiment Name : Load Flow Study Using MatLab 

 

 

 

 

Introduction : 

The steady state operation of power system as a topic for study is called load flow analysis. The load 

flow analysis is important for best operation of the existing system and for future expansion of power 

system. Principal information obtained from load flow analysis: 

1. Magnitude of voltage at each bus. 

2. Phase angle of voltage at each bus. 

3. Real and reactive power flowing in each line. 

  

Variables for load flow study are listed below 

 

 

 

 
Normally only one bus is connected as slack/swing bus in a given power system. The need of such a 

bus is that the net complex power flow into the network is not known in advance, the system power 

loss is being unknown till the load flow study is complete. It is therefore necessary to have one bus as 

slack bus at which the complex power is unspecified, so that it supplies the difference in the total 

system load plus losses and the sum of the complex power specified at the remaining bus. The 

necessary conditions are: 

1. Slack bus must be a generator bus 

2. The voltage angle of the swing generator is set zero or any arbitrary value so its voltage 

becomes the reference point for other voltages of the system. The bus connected to the largest 

generating station is usually selected as slack bus. 

Bus Type Known Variable Unknown Variable 

Swing/Slack/Reference Bus V, δ ( δ=0 ) P,Q 

PV/Generator/Voltage 

Controlled Bus 
P,V Q, δ 

PQ/Load Bus P,Q V, δ 

Because of the non linearity of the equations of real and complex power of different buses, the 

solution is usually obtained by an iterative method. Most common two methods are: 

1. Gauss Seidel method. 

2. Newton Raphson method. 

In this experiment we will consider the Gauss Seidel method for load flow study. 

Gauss Seidel method: 

Assumption: 

1. Bus no 1 is swing bus. 

2. Remaining generator buses are consecutively numbered as 2,3,4…………………G. 

3. The load buses are numbered as G+1,G+2,………N. 
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Information regarding variables: 

 

 
Procedure : 

Development of a MATLAB based software tool for load flow analysis using Gauss-Seidal 

method 

 

1. Input Data Format 

(a)Power- voltage profile of every bus should be given as follows 

Table 1 

 

Bus(i) P(i) =Pg-Pd 

pu 

Q(i)=Qg-Qd 

pu 

V(i) pu Δ(i) Remarks(optional) 

1 - - 1.04 0 Slack 

2 0.5 - 1 - PV  

3 -1.0 0.5 - - PQ 

4 0.3 -0.1 - - PQ 

 

Note: Slack bus No=1, PV bus no =2-G, PQ bus no=G+1-N.  

Where, N= Total No of Buses. G=No of the last PV bus(<=N) 

 

 

 

Bus Type Known Unknown 

Swing Bus (1) V1=V1 ( angle=0 ) P1,Q1 

Generator Bus 

(K=2,3,……G) 
Pk,Vk Qk, δk 

Load Bus 

(K=G+1,G+2,…….N) 
Pk,Qk Vk, δk 

(b) The Line data should be given as follows 

Table 2 

 

Line (from bus to bus) R pu X pu 

1-2 0.05 0.15 

1-3 0.10 0.30 

2-3 0.15 0.45 

2-4 0.10 0.30 

3-4 0.05 0.15 

 

2.Output format:  

  

(a) All the unknown variables in table 1 should be known.  

(b) The line to line power flow should be determined also. 

(c) The iteration number of the stage when the result is found. 

(d) Results should be presented in a well formatted text file. 

 

3. Main Equations required: 

 

 
Q_new(i)= -Imag { V

*
(i) x ( 



N

K

Y
1

(i,k) V(k))}                                 (1) 

 

V_new(i)=
),(

1

iiY























N

iK
K

Y
iV

ijQiP

1

V(k) k)(i, 
)(*

)()(
                           (2) 
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Helpful hints:  

1. Assume all unknown voltage to be 1 pu , all unknown  δ to be 0. 

2. Assume all unknown P and Q be equal to inf (a variable defined in MATLAB). 

3. Take input of the total bus number. Using ‘input’ function of MATLAB. 

As example: 
no_bus=input('Total no of bus is'); 

 

4. Store V, δ, P and Q in different row vectors in a user friendly way. Use ‘sprintf ’ & 

‘input’ function in a loop. 

As example 
   for i=1:no_bus 
       sprintf('The voltage of bus %d is',i)   
       v(i)=input('') 
       end 

. 

5. Formation of YBus Matrix. Use ‘sprintf ’ & ‘input’ function in a loop to take input of 

r and x from table 2. You have to use 2 for loops nested together. [Try to use the 

lowest number of loops] 

6. set a variable for iteration count=1 

7. Start calculation of bus 2 first. Try to identify whether it is a PV bus or PQ bus 

depending on the values of P and Q. If Its  PV bus use both equation 1 and 2 to get the 

new value of Q and δ as Q_new(i) and delta_new(i). use ‘Angle’ function to get 

delta_new from equation 2. As soon as a new value is generated  do the following 

two tasks instantly without going for the next calculations. 

a. Find the difference between the old value and the new value for each variable 

and store the maximum among them in a variable may be known as ‘del’. 

b. Replace the older value with the newer value. 

8. If it’s a PQ Bus use only equation (2) to get V_new(i) and delta_new(i) using ‘abs’ 

and ‘angle’ functions of MATLAB. Do the same things as in 7(a) and 7(b). 

9. After calculation of all buses are completed, check whether  

                                  del <  .0001 

If it is so we have obtained the result and we have to go to the next step. If its not you 

have to increase the iteration count by 1 and go back to step 7 again. 

      10. Calculate the real and reactive power of bus 1 using following equations  

P(1)= abs { V
*
(1) x ( 



N

K

Y
1

(1,k) V(k))}                                 (3) 

 Q(1)= -Imag { V
*
(1) x ( 



N

K

Y
1

(1,k) V(k))}                             (4) 

11. Calculate the line to line flow using following equation 
 

S(i,j )= V(i) {(V(i) - V(k))Y(i,k)}
*
                                          (5) 

 

Note: Use ‘fprintf’ function of MATLAB for storing the results in a text file. 

 

 

Report : 

1. Calculate manually the values that you have obtained from computer and compare them. 

Show all the calculations. 

2. Discuss on the experiment. 
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1. Introduction 

 
PowerWorld Simulator (PW Simulator) is a power system analysis and simulation software 

package that accompanies the textbook “Power System Analysis and Design” by J. Duncan 

Glover and Mulukutla S. Sarma. A CD is provided together with the book to install the software. 

The PowerWorld Simulator can be installed by following the instructions on the CD. After 

installing the PW Simulator, double-click on the PW icon to start the program. 

 

There is a brief introduction of the PW Simulator in Section 1.5 of the textbook. You are 

encouraged to read that section and experience the features of the program yourself. This 

appendix also helps you to get started with the software. 

 

2. Analyze a Sample Case 

 
Open a sample case by clicking ‘Open Case’ under ‘File’ menu. Select case B7flatlp.pwb in 

‘Non-Glover & Sarma Examples’ directory. The following sample case is then loaded to the 

Simulator. The features of the software are then introduced using this sample case.  

 

Basic menu functions: 

 

Similar to other Windows applications, the upper part of the figure shows the menus and toolbars 

of the program, the bottom part shows the current working case. The basic menu includes the 

following functions: 

 

File:  open, save, close and print the study case; 
 

Simulation:   start, pause, resume the simulation of the study case. Once the simulation is 

started, an animated picture of power flow will be shown; 
 

Case Information:  The case information, input and output are summarized in the menu; 
 

Options/Tools:  providing the analyzing tools and options; 
 

LP OPF:  providing the options for OPF calculation; 
 

Window:  Similar to other applications, all opened files are listed here; 
 

Help:  providing help to the users. 

Experiment No.: 9

Experiment Name : Introduction to PowerWorld Simulator
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As introduced in the textbook, The PM Simulator provides two modes, one for editing and the 

other for running. 

 

Solve the case: 

 

1).  Click the ‘Run Mode’ button. 

2).  Select ‘Play’ of the ‘Simulation’ menu. 

3). The case is then solved. Observe the one-line diagram. 

 

Inspect results: 

 

1).  The results can be observed directly from the one-line diagram. The voltages are listed 

besides the buses. The real and reactive power output of the generators, the power flows 

along the lines, etc. You can also change the items displayed in the one-line diagram. 

2).  Output results can also be obtained from ‘Case Information’ menu. Under ‘Run Mode’, 

select ‘Buses’, for example, the table containing bus records appears. Tables for generators, 

loads, transmission lines can also be accessed similarly.  



AUST/EEE
 

 

 

Edit input data: 

 

You can edit the input data directly from the one-line diagram. For example, edit the input date 

of a generator: 

 

1).  Go to ‘Edit Mode’. 

2).  Right-click the generator in the one-line diagram.  

3).  Select ‘Information Dialog’. A dialog box appears and shows input date (it is shown below).  

4).  Change the data as you wish.  
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3. Create a -ew Case 
 

A new case shown in the figure below can be created easily using PowerWorld Simulator.  

 

 

 
 

This simple case consists of 3 buses. Bus 1 is connected to the utility (Source). A generator is 

connected to Bus 2. Bus 3 provides power to the load. One transmission line (from Bus 2 to 3) 

and one transformer (from Bus 1 to 3) build up the network. A switched shunt is available to 

boost bus voltage. 

 

3.1 Input of buses 

 

Here are the steps to input Bus 1: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Bus’. 

3).  Place the bus to your selected position by clicking on the one-line diagram.  

4).  A dialog box named ‘Bus Options’ appears, shown in the next page. 

5).  Enter the necessary information shown in the dialog boxes into your computer. 

6).  Make sure the ‘System Slack Bus’ box is checked. Bus 1 is the slack bus since it is 

connected to the utility. 

7).  Click OK. This finishes the input of Bus 1. 
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Bus 2 and 3 can be input similarly. They are shown in the following figures. Please note: 

 

• Bus 2 is a PV bus and is connected to a generator. Therefore voltage setting is needed. 

Enter ‘0.995’ in the corresponding box. No need to input the angle setting box. 

• Bus 3 is a typical PQ bus. Neither voltage setting nor angle setting information is needed. 

 

 

  
 

This box defines the general information 

about a bus. In this example, Bus 1 has 

rated voltage of 69kV. It is a slack bus. 

Therefore, both voltage and angle settings 

are needed. Also the nominal voltage of 

the bus should be set. 
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3.2 Input of Components 

 

Typical components in a power system include generator, motor and load, capacitor etc.. The 

utility supply system is represented as a generator with unlimited capacity. In this example, we 

will learn how to use PM Simulator to model these components.  

 

Steps to input the utility supply system and generator of this example: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Generator’. 

3).  Place the component close to the bus that it is connected to.  

4).  A dialog box named ‘Generator Options’ appears, shown in the figure below. 

5).  After set the orientation to display the generator, click ‘MW and Voltage Control’ button. 

Some new fields appear in the dialog box.  

6).  Enter the necessary information shown in the dialog boxes into your computer. 

7).  Click OK. This finishes the input of the utility supply system/generator. 

 

 
 

 

This box defines the display 

information of a generator, 

such as the display size, 

thickness, orientation etc. 

The component entered here 

represents the utility system, 

which is place upward. 
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The dialog box containing the control information of the generator (connected to Bus 2) are 

shown below. Enter the data into your computer. 

 

 
 

This box defines the 

control information for the 

utility. The MW and Mvar 

output will be calculated 

and filled in automatically 

by the program. The 

voltage setpoint is 1.0. 

 

 

 

You can click ‘Help’ at 

any time to find out the 

meanings of the required 

fields. 

This generator outputs 2MW. 

The Mvar output will be 

calculated and filled in by the 

program. The voltage setpoint 

is 0.995 in this case. 

 

 

 

A motor can be modeled in 

the same way as a generator. 

Just define the MW and 

Mvar output values to be 

negative. 
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Steps to input the load of this example: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Load’. 

3).  Place the component close to the bus that it is connected to (Bus 3).  

4).  A dialog box named ‘Load Options’ appears, shown in the figure below. 

5).  Enter the necessary information shown in the dialog boxes into your computer. 

6).  Click OK. This finishes the input of the load. 

 

 
 

 

Steps to input the shunt capacitor of this example: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Switched Shunt’. 

3).  Place the component close Bus 3.  

4).  A dialog box named ‘Switched Shunt Options’ appears, shown in the figure below. 

5).  Enter the necessary information shown in the dialog boxes into your computer. 

6).  Click OK. This finishes the input of the shunt capacitor. 

This box defines the general 

information about a load.  

 

This load is a constant power 

load of 7MW and 6.3Mvar.  
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3.2 Input of Lines/Transformers 

 

Buses in a power system are usually connected by either transmission lines or transformers. PM 

Simulator models the transmission line and transformer as follows. 

  

Steps to input the transmission line of this example: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Transmission Line’. 

3).  Place the transmission line in the one-line diagram: click the ‘from bus’ (Bus 2) of the line 

and then double click the ‘to bus’ (Bus 3) of the line.  

4).  A dialog box named ‘Transmission Line/Transformer Options’ appears, shown in the figure 

below. 

5).  Enter the necessary information shown in the dialog boxes into your computer. 

6).  Click OK. This finishes the input of the line. 

 

This box defines the information 

about a shunt capacitor.  

 

The nominal Mvar of the shunt in 

this case is 6Mvar. 

 

 

 

 

 

 

 

Click ‘Help’ to read instructions 

on data input. 
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Steps to input the transformer of this example: 

 

1).  Go To ‘Edit Mode’. 

2).  Click ‘Insert’ menu and select ‘Transformer’. 

3).  Place the transformer in the one-line diagram: click the ‘from bus’ (Bus 1) of the line and 

then double click the ‘to bus’ (Bus 3) of the line.  

4).  A dialog box named ‘Transmission Line/Transformer Options’ appears, shown in the figure 

in the next page. 

5).  Enter the impedance information shown in the dialog boxes into your computer. 

6).  Click box ‘Transformer Control’. Some new fields appear. Enter the corresponding control 

data. 

7).  Click OK. This finishes the input of the transformer. 

 

Now the simple case has been established. You may use the procedure described in Section 2 to 

inspect the input data in table format.  

 

 

This box defines the information 

about a transmission line. The 

impedance is in per unit. The per 

unit base value is defined in 

‘Solution/Environment’ option. 

 

The per unit impedance of this 

line is 0.06+j 0.12. 

 

 

 

 

 

Click ‘Help’ to read instructions 

on data input. 
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You can also choose to display more information of the case in the one-line diagram. For 

example, the load parameters can be displayed according to the following steps: 

 

This box defines the information 

about a transformer. The input 

impedance is in per unit. The per 

unit base value is defined in 

‘Solution/Environment’ option. 

 

The per unit impedance of this 

line is 0.03+j 0.53. 

 

 

 

 

 

Click ‘Help’ to read instructions 

on data input. 

This box defines the control 

information of transformer.  

 

This transformer is not used for 

phase shifting. The turns ratio 

here is 1.01.  

 

 

 

 

 

Click ‘Help’ to read instructions 

on data input. 
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1).   Go to ‘Edit Mode’. 

2).  Right Click on the load. Select ‘Add New Fields Around Load’. 

3).  A dialog box appears asking you to choose the position of the new field. Choose the position 

as you wish. 

4).  A new dialog box named ‘Bus Field Options’ appears. From ‘Type of Field’, select ‘Load 

MW’. The value of load MW then displays in the one-line diagram. 

 

Similarly, the one-line diagram can be adjusted to display more information about generators, 

buses and branches. Once the case is solved, the load flow results (bus voltages, branch currents) 

can also be displayed, as shown below. 

 

 
 

 

 

 

Generator 

Output 

Transformer 

Current H-Side 

Load 

Parameters 

Shunt Capacitor 

Output 

Bus Voltage 

(magnitude 

and angle) 

Transformer 

Current L-Side 

Line Current 
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4. Analysis Tools 
 

PowerWorld Simulator provides several tools for power system analysis. The tools used in 

EE433 labs include Power Flow Simulation, Fault Analysis and Scale Case. These tools are 

available from the ‘Options/Tools’ menu or ‘Simulation’ menu. 

 

4.1 Power Flow 

 

Power Flow is the most fundamental and commonly used tool for steady-state power system 

analysis. In the PW Simulator, power flow can be carried out by selecting ‘Play’ from the 

‘Simulation’ menu. An animated power flow diagram is then displayed and helps you to have an 

intuitive feeling about power flow directions and relative values. 

 

The options of the PW Simulator can be accessed by selecting ‘Solution/Environment’ from the 

‘Options/Tools’ menu. The following diagram shows the general options for Power Flow 

Solution. Other options such as ‘Automatic Controls’, ‘Area Interchange’, ‘Storage’ are also 

available by clicking the buttons at the bottom of the dialog box. These options affect the results 

of power flow analysis. Make sure they have been set to the appropriate values before running 

the power flow simulation. 
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4.2 Fault Analysis 

 

Fault analysis is also a commonly used tool for power system analysis. In PW Simulator, this tool 

can be activated by selecting ‘Fault Analysis’ from the ‘Options/Tools’ menu. Before running 

fault analysis, the fault parameters of all components need to be entered first. 

 

 

 

Input Fault Parameters: 

 

Fault parameters of power system components can be entered at the same time when the 

component records are created. Using a generator as an example, the following dialog box 

appears when the generator record is created. Click the button ‘Fault Parameters’, the parameters 

relating to fault analysis can be entered in the corresponding fields. 

 

 

 
 

 

Run Fault Analysis: 

 

When ‘Fault Analysis’ is activated, the following dialog box appears: 

 
 



AUST/EEE  
This box defines the faulted bus and the fault type. After entering these information, click the 

‘Calculate’ button. The fault current is then displayed at the upper right corner and the detailed 

fault analysis results are shown in the bottom table.  

 

 

4.3 Scale Case Tool 

 

In some case studies, the load and/or generations of the power system need to be scaled (e.g. in 

voltage stability study). This can be carried out using the ‘Scale Case’ tool provided by PW 

Simulator. This tool will be further introduced in Lab 4 when voltage stability of a simple system 

is assessed. 

 

 

 

This tutorial is only a brief introduction of the PowerWorld Simulator. You are encouraged to try 

and experience by yourself. Remember, you can always click the ‘? Help’ button on each dialog 

page to get instructions on input and output. 
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Objective  
The objective of this experiment is to familiarize with the PowerWorld Simulator, which is an 
interactive power system simulation package. The simulator has a user-friendly graphical 
interface which facilitates the modeling of power systems in the oneline diagram form. 
Oneline diagrams are used in power system analysis to represent the actual three-phase power 
system using a single line to represent each three-phase device. 
Procedure 
We will create a simple power system model using PowerWorld Simulator. A simulation 
model is called a Case. To create a new case, select New Case from PowerWorld icon.  
 
To insert a bus:  

• Select Network > Bus from the Individual Insert group on the Draw tab. This 
prepares Simulator to insert a new bus.  

• Left-click on the oneline background at the location where you want to place the new 
bus. This opens the Bus Option Dialog (below), which is used to specify various 
display properties, and the load and shunt compensation connected to the bus. 

• The Bus Number field automatically displays ‘1’. Enter a suitable name to the Bus 
Name field, e.g. One. 

• Next check the  System Slack Bus field. Then, click OK to close the dialog box. 
 

 
 

To connect a generator:  
 

• Select Network > Generator from the Individual Insert group on the Draw tab.   
•  Left-click the bus on the oneline diagram to which you want to attach the generator 

(for this example, click on the slack bus – bus One.) The Generator Option Dialog 

Experiment No.: 10
Experiment Name : Load Flow Study Using  PowerWorld Simulator
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(below) will open. The dialog is used to specify the new generator’s display properties 
and various power outputs. 

• Click OK on the Generator Option Dialog. After the dialog box closes, the new 
generator will appear on the oneline attached to the previously selected bus.  
 

 
 

To enter the second bus with load: 
 

• Repeat the above procedure for entering the first bus. In the Bus Options Dialog 
(below) leave the bus number at the default value of 2, and enter the name ‘Two’ in 
the Bus Name field. 

• Now we will connect a 200 MW, 100 Mvar load to this bus.  Select the Attached 
Devices tab. Under the Load Summary Information heading enter ‘200’ in the Base 
MW field and ‘100’ in the Base Mvar field. Click OK to close the Bus Options 
Dialog and insert the bus. 

• At this point the oneline diagram does not show the load at bus 2, even though it is 
represented in the power system model. To draw the load on the oneline diagram, 
select Network > Load from the Individual Insert group on the Draw tab. 

• Left-click in the center of this bus. The Load Options Dialog box opens. The 
Constant Power MW and Mvar fields show that the load is 200 MW and 100 Mvar. 

• Select Up in the Orientation field under the Load Information tab to make the load 
point upward. Verify that the anchored box is checked. This will force the load to 
move when the bus is moved. 

• Click OK to close the Load Options dialog and insert the load. A circuit breaker 
symbol is automatically included with each load. 
 

To insert a transmission line: 
 

• Select Network > Transmission Line from the Individual Insert group on the Draw 
tab. 

• Left-click at the point where you want the new line to originate. For this example, 
originate the line at bus One. Without holding down the mouse button, drag the mouse 
up. To terminate a line segment, click the left mouse button. Each time you click the 
mouse to terminate a line segment, a new vertex is defined for the line. To draw the 
next line segment, move the mouse to the desired location of the next vertex. 
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• To terminate the final line segment and conclude drawing the line, double click the left 
mouse button at the desired termination point (bus Two for this example). 

• The Transmission Line/Transformer Dialog appears (below). The dialog should 
already contain a 1 in the From Bus Number field and a 2 in the To Bus Number 
Field. 

• The Series Resistance, Series Reactance, and Shunt Charging fields are used to 
enter the per unit parameters of the line. The Shunt Charging field contains the total 
per unit charging capacitance for the line. Enter the values shown in the Dialog box. 

• Click OK to close the Transmission Line/Transformer Dialog, and insert the new line. 
• When the line is drawn it automatically has a line flow pie chart included. Additional 

line flow pie charts can be included by selecting Pies/Gauges > Line Flow Pie Chart 
from the Individual Insert group on the Draw tab, and then clicking near a line. 
 
 

 
 

 
To insert a Transformer: 
 

To insert a transformer we first need to insert a bus at a different voltage level. Insert a new 
bus in the bottom of the oneline, named Three, and enter 69 KV for its nominal voltage in 
the Bus Options dialog box. To insert a transformer between buses 2 and 3: 

 
• Either go to Network > Transformer from the Individual Insert group on the Draw 

tab. Click on bus 2, and then draw a line to bus 3 as you did for a transmission line. The 
Transmission Line/Transformer Dialog appears. 

• On the Parameters tab, enter 0.02 for Series Resistance, 0.08 for Series Reactance, 
0.1 for Shunt Charging and 1000 for Limit A (MVA). 

• Select the Transformer Control tab. The Off-nominal Turns Ratio displays 1.000. 
The true transformer turns ratio does not need to be specified as it is automatically 
determined by the ratio of nominal voltages between the From Bus and To Bus. 

• Click OK to close the dialog and insert the transformer. 
• Repeat this procedure to add a transformer between buses 1 and 3. 
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• Repeat the procedures described above to add 400 MW, 200 Mvar load, and a 300 
MW generator to bus 3.  

• After these additions the oneline diagram should resemble the Figure-1. 
 
 

 

Figure-1 
 
 
 
 
  

 
 

 
 
 
 
 
  
 
 
 

 
 
 
 

Add a Load and a Generator to bus 3:
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GENERATOR FEEDING A LOAD THROUGH A TRANSFORMER 

Objective  
 
The objective of this experiment is to simulate a simple power system, where a three-phase 
generator feeds a load through a three-phase transformer, using the PowerWorld Simulator.  
 

 Preliminary Work 
 
The oneline diagram of the system is shown in Figure-2. The ratings of the 
components in the system are 
 
Generator G: 120 MVA, 20 kV, synchronous impedance Zs = 0.1 +j 0.2 Ω / phase Y. 
 
Transformer T: 150 MVA, 20Δ / 138Y  kV, per phase winding resistance and leakage  
                         reactance of the high voltage side : R = 2 Ω, X = 5 Ω.  
 
Load:   100 MW + j 40 Mvar at 138 kV (constant impedance load). 
 

YΔ

G

T1 2

Load

 
FIGURE -2 

 
A system base of 150 MVA, 20 kV is chosen on the low voltage side of the 
transformer. 
 

(a) Calculate the per unit impedances of all the components with respect to their 
own bases. 

(b) Calculate the per unit impedances of all the components with respect to the 
system base. 

(c) Keeping the voltage at bus 1 at 1.0 pu, calculate the following 
i. The per unit load voltage. 

ii. The real power in MW supplied to the load. 
iii. The reactive power in Mvar supplied to the load. 
iv. The real power delivered by the generator at bus 1. 
v. The reactive power delivered by the generator at bus 1. 
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(a) Draw the oneline diagram of the system in the PowerWorld Simulator, using the 
procedures described in Experiment 1. The system schematic should look like the one 
shown in Figure-3. 

(b) Enter all the per unit parameters of the devices calculated in the Preliminary Work 
using the appropriate dialog boxes. 

(c) Simulate the system using the Play icon under the Tools group.  
(d) From the solution given by the Simulator, note down all the variables that had been 

calculated in the Preliminary Work. 
 

 
FIGURE -3 

 
Results and Discussions 
 

(a)  Compare the results from your calculation with those from the Simulator. 
(b)  If the two results do not match, try to figure out how the discrepancy arises. 

 
 

 

 
 
 
 

 
 
 
 
 

 
  

 
 

 

 Procedure 
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TRANSMİSSİON LİNE 

Objective  
 
The objective of this experiment is to simulate a simple power system, where a three-phase 
generator feeds a load through a transmission line and associated three-phase transformers, 
using the PowerWorld Simulator.  
 
Preliminary Work 
 
The oneline diagram of the system is shown in Figure-4. The ratings of the 
components in the system are 
 
Generator G: 120 MVA, 20 kV, synchronous impedance Zs = 0.1 +j 0.2 Ω / phase Y. 
 
Transformers:  
T1: 150 MVA, 20Δ / 138Y  kV, per phase winding resistance and leakage  
       reactance of the high voltage side : R = 2 Ω, X = 5 Ω. 
T2: 150 MVA, 138Y / 13.8 YkV, per phase winding resistance and leakage  
       reactance of the high voltage side : R = 1.8 Ω, X = 4 Ω. 
Transmission line: 
z = 0.04 +j 0.1 Ω/km, y = j 4×10-6 S/km, length = 100 km. 
 
Load:   100 MW + j 40 Mvar at 13.8 kV (constant impedance load). 
 

YΔ

G

1

Load

T1 T2 2

Y Y

transmission line

 
 

FIGURE-4 
 
 

A system base of 100 MVA, 20 kV is chosen on the low voltage side of transformer 
T1. 
 

(a) Calculate the per unit impedances of all the components with respect to the 
their own bases. 

(b) Calculate the per unit impedances of all the components with respect to the 
system base. 

(c) Keeping the voltage at bus 1 at 1.0 pu, calculate the following 
i. The voltages at the sending and receiving ends of the transmission line. 

ii. The real and reactive power flow at the sending end of the transmission 
line. 
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iii. The real and reactive power flow at the receiving end of the 
transmission line. 

iv. The real and reactive power supplied to the load. 
v. The load voltage in per-unit and kV. 

 
Procedure 
 

(a) Draw the oneline diagram of the system in the PowerWorld Simulator, using the 
procedures described in Experiment 9 The system schematic should look like the one 
shown in Figure-5 

(b) Enter all the per unit parameters of the devices calculated in the Preliminary Work 
using the appropriate dialog boxes. 

(c) Simulate the system using the Play icon under the Tools group.  
(d) From the solution given by the Simulator, note down all the variables that had been 

calculated in the Preliminary Work. 
 

 

 
FIGURE -5 

 
 
 
Results and Discussions 
 

(a)  Compare the results from your calculations with those from the Simulator. 
(b)  If the two results do not match, try to figure out how the discrepancy arises. 
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POWER FLOW 1 

 Objective  
The objective of this experiment is to solve the power flow problem for a simple 
power system, which is the system in Figure 5, using the PowerWorld Simulator.  

 Preliminary Work 
The oneline diagram of the system is shown in Figure-6. Bus 1 is the slack bus and 
bus 4 is the load bus. The ratings of the components in the system are 
 
Generator G: 120 MVA, 20 kV, synchronous impedance Zs = 0.2 +j 1.2 Ω / phase Y. 
 
Transformers:  
T1: 150 MVA, 20Δ / 138Y  kV, per phase winding resistance and leakage  
       reactance of the high voltage side : R = 2 Ω, X = 5 Ω. 
T2: 150 MVA, 138Y / 13.8 YkV, per phase winding resistance and leakage  
       reactance of the high voltage side : R = 1.8 Ω, X = 4 Ω. 
 
Transmission line: 
z = 0.04 +j 0.1 Ω/km, y = j 4×10-6 S/km, length = 100 km. 
 
Load:   100 MW + j 40 Mvar (constant power load). 
 

G

1

transmission line
Load

T1

Δ Y Y Y

T22 3 4

 
FIGURE -6 

 
A system base of 100 MVA, 20 kV is chosen on the low voltage side of transformer 
T1. Use the nominal-π circuit model for the transmission line. Solve the power flow 
problem for this system and find the following for these cases: starting from 20% of 
the nominal value given above, load power is increased in steps of 20% up to the 
nominal value. 
 

1) The load (bus 4) voltage. 
2) The transmission line currents at the sending and receiving ends. 
3) The real and reactive power supplied by the generator at bus 1. 

 
NOTE that the presence of transmission line shunt admittances complicates the 
problem. You may adopt one of the following two approaches:  
Method 1: 

(a) Find the Thevenin equivalent of the system to the left of bus 4, thus eliminating 
buses 2 and 3. 
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(b) Write the Newton-Raphson equations for the unknown voltage of bus 4 in 
terms of the Thevenin voltage and impedance. 

Method 2:  
(a) Accept buses 2 and 3 as load buses with zero loads.  
(b) Write the Newton-Raphson equations for the unknown voltages of buses 2,3 

and 4 using Ybus four the 4-bus system.  
 

 Procedure 
(a) Use the oneline diagram of the system you have drawn for Figure 5. 
(b) Change the type of the load from “constant impedance” to “constant power”. 

For this, you enter zeros for load power values under “constant impedance” 
and enter the desired values under “constant power”. 

(c) Simulate the system using the Play icon under the Tools group.  
(d) From the solution given by the Simulator, note down all the variables that had 

been calculated in the Preliminary Work. 
(e) Compare the results from your calculation and those from the Simulator. If the 

two results do not match, try to figure out how the discrepancy arises. Then 
make the necessary corrections to your simulation model and repeat the 
procedure. 

 
     FIGURE -7 

 
 

 Results and Discussions 
(a) Tabulate the results from the simulation, showing all values versus load, as in 

Table -1. 
(b) Discuss what happens as the load is increased from 20% to 100%. 

 
    TABLE -1 

 
Transmission line currents Slack bus power Load (%) Load voltage 

(pu) Sending end(A) Receiving end(A) P(MW) Q(Mvar) 
20    
40    
60    
80    

100    
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POWER FLOW 2 

 Objective  
The objective of this experiment is to analyze the power flow in a given power system using the 
PowerWorld Simulator. Power flow solutions will be obtained using the Gauss-Seidel and the 
Newton-Raphson methods, and the progress of the solutions through the iterations will be 
observed. (Reference: Example 6.9, p.277, Power System Analysis and Design, Glover-Sarma).   

 Preliminary Work 
The oneline diagram of the system is shown in Figure-8. The data for the components in 
the system are given in per unit in Tables-2,3 and 4. The base values are Sbase=100 MVA, 
Vbase=15 kV at bus 1. The ratings of the devices are: 
 
Generator G1:  400 MVA, 15 kV 
Generator G2:  800 MVA, 15 kV 
Transformer T1:  400 MVA, 15 Δ / 345 Y kV 
Transformer T2:  800 MVA, 345 Y / 15 Δ kV 
Lengths of transmission lines:  L1=200 mi, L2=100 mi, L3=50 mi. 

 

T1
G1

G2
1

2

5 4 3

L1L2

L3

80 MW
40 Mvar

800 MW
280 Mvar

T2

 
                                 FIGURE -8 

 
 

TABLE -2  Bus input data 
 

Bus Type V 
p.u 

δ 
degrees

PG 
p.u. 

QG 
p.u. 

PL 
p.u. 

QL 
p.u. 

QGmax 
p.u. 

QGmin 
p.u. 

1 Swing 1.0 0 - - 0 0 - - 
2 Load - - 0 0 8.0 2.8 - - 

3 Voltage-
controlled 1.05 - 5.2 - 0.8 0.4 4.0 -2.4 

4 Load - - 0 0 0 0 0 - 
5 Load - - 0 0 0 0 0 - 
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TABLE -3 Line input data 
 

Bus-to-bus R 
p.u. 

X 
p.u. 

G 
p.u. 

B 
p.u. 

Maximum MVA
p.u. 

2-4 0.009 0.1 0 1.72 12.0 
2-5 0.0045 0.050 0 0.88 12.0 
4-5 0.00225 0.025 0 0.44 12.0 

 
 

TABLE -4 Transformer input data 
 

Bus-to-bus R 
p.u. 

X 
p.u. 

Gc 

p.u. 
Bm 

p.u. 
Maximum MVA

p.u. 
1-5 0.0015 0.02 0 1.72 6.0 
2-5 0.00075 0.01 0 0.88 10.0 

 
 

(a) Calculate Ybus for the system using the data in the tables. 
(b) Using the initial values given in Table 2, perform one Gauss-Seidel iteration 

for bus 2 and 3 voltages V2(1) and V3(1). Note that bus 3 is a voltage-controlled 
bus.  Therefore, correction must be applied to the magnitude of V3(1) to force it 
to have the specified value ( 3 1.05V = ). 

(c) In the Newton-Raphson method, calculate the initial power mismatches at all 
the buses 2-5. Also, calculate the Jacobian matrix elements of the partition J11. 
(NOTE: a power mismatch at a bus “k” is defined as , ,( ) ( )k k sch k calcP n P P nΔ = − , 
where ,k schP  is the scheduled real power and , ( )k calcP n is the power calculated 
from the power flow equation after iteration n. 
 

 Procedure 
 

(a) Draw the oneline diagram of the system in the PowerWorld Simulator, using the 
procedures described in the introduction section. The system schematic should look 
like the one in Figure-9. 

(b) Enter all the per unit parameters of the devices given in the tables, using the 
appropriate dialog boxes. 

(c) Under the “Tools” group, open the “Simulator Options” dialog. Under “Power Flow 
Solution” check the “Do Only One Iteration” box. Then, in the “Run Mode” open 
the “Solve” menu and choose “Gauss-Seidel Power Flow”. The Simulator will 
perform one Gauss-Seidel iteration.  

(d) Note down all bus voltages (magnitude and phase) and power mismatches at the end 
of the first iteration. For power mismatches, go to Case Information  Network 

Power Mismatches.  
(e) Proceed in single-steps through the solution by repeatedly selecting “Gauss-Seidel 

Power Flow”. Perform 10 iterations and repeat step (d) at the end of each iteration. 
Arrange your results in the form of a table (Table A). 
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(f) Now, in your oneline diagram reset all voltages and power values to their initial values 
(In Edit Mode). Then, in the “Run Mode” open the “Solve” menu and choose “Polar 
NR Power Flow”. The Simulator will perform one Newton-Raphson iteration. 

(g) Repeat steps (d) and (e) for 5 iterations. Arrange your results in the form of a table 
(Table B). 

 

slack

One

394.8 MW
114.3 Mvar

Five

A

MVA

Four

A

Amps

Two

A

Amps

A

Amps

 800 MW
 280 Mvar

Three

A

MVA

 520 MW
   0 Mvar

  80 MW
  40 Mvar

1.0000 pu
1.0500 pu
0.0000 Deg

1.0000 pu
0.0000 Deg1.0000 pu

0.0000 Deg

1.0000 pu
0.0000 Deg

 
      
     FIGURE -9 

 
 
 

 Results and Discussions 
 
(a) Compare the results from your calculations in the Preliminary Work and those from the 

Simulator. 
(b) If the two results do not match, try to figure out how the discrepancy arises. 
(c) Plot the power mismatches at all buses versus iteration number n, for both of the methods. 

Compare the convergence rates of the two power flow solution methods.  
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DESIGN PROJECT: POWER FLOW 

 Objective  
The objective of this experiment is to analyze the power flow in a given power system using 
the PowerWorld Simulator, and design a different operating strategy to change certain system 
variables. (Reference: Design Project 4, p.315, Power System Analysis and Design, Glover-
Sarma).   

 Preliminary Work 
The oneline diagram of the system is shown in Figure-9. The ratings of the 
components in the system are 
 
Generator Ratings: 
G1: 100 MVA, 13.8 kV, x = 0.12 pu. 
G2: 200 MVA, 15 kV, x = 0.12 pu. 
  
Transformer Ratings:  
T1: 100 MVA, 13.8 kV Δ / 230 kV Y, X = 0.1 pu. 
T2: 200 MVA, 15 kV Δ / 230 kV Y, X = 0.1 pu.  
 
Transmission Lines: 
All lines 230 kV, z = 0.08 +j 0.5 Ω/km, y = j 3.4×10-6 S/km 
Maximum MVA = 400 MVA 
Line lengths:  L1 = 15 km, L2 = 25 km, L3 = 40 km, L4 = 15 km, L5 = 50 km, 
 
Power Flow Data: 
Bus 1: Swing bus,  V1 = 13.8 kV , 1 0δ = o . 
Bus 2,3,4,5,6: Load buses. 
Bus 7: Generator bus,  7V 15 kV= , PG7  = 180 MW, -87 Mvar < QG7 < + 87 Mvar. 
 
System base quantities: 
Sbase = 100 MVA 
Vbase = 13.8 kV in the zone of G1. 
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FIGURE -9 

 
(a) Convert all impedances, load and voltage data to per unit using the system base 

values. 
(b) Prepare the following input data files for this system similar to the ones in 

Experiment 5: Bus input data, Line input data, Transformer input data. 
 

 
 Procedure 

(a) Draw the oneline diagram of the system in the PowerWorld Simulator and verify 
that the input data files you prepared are the same as those given by the Simulator. 

(b) Run the Simulator and obtain the voltages at all the buses. 
(c) Suggest a method for increasing the voltage magnitude at bus 4 by 5%. Demostrate the 

effectiveness of your method by making appropriate changes to your model and 
solving the power flow problem. You may consider applying one or more of the 
following: generator excitation control, tap changing and regulating transformers, 
static capacitors, static var systems, and parallel transmission lines. 
 

 Results and Discussions 
Discuss the effectiveness of your solution with respect to the achievement of the target 
and the cost of implementation.   
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